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Keyboard Usage

Key(s) Function

/\ Scrolls the selection list or directory tree 1 line up

\/ Scrolls the selection list or directory tree 1 line down

Home Position at the top of the selection list or directory tree.

End Position at the end of the selection list or directory tree

PgUp Scrolls the selection list or directory tree 1 window up.    If the window contains
exactly n lines, PgUp will scroll that many lines.    If a partial line is showing, 
PgUp will move the top line to the bottom of the window partially showing the 
line.

PgDn Scrolls the selection list or directory tree 1 window down    If the window 
contains exactly n lines, PgDn will scroll that many lines.    If a partial line is 
showing, PgDn will move the bottom partial line to the top of the window.

<spacebar> Selects the file or directory at the top of the window.

Shift Selects a file or directory ranges in extended selections.

Ctrl Selects an additional file or directory in extended selections.

Delete Invokes the Delete Selections dialog.

Ctrl+d Invokes the List Dir(s) w/Spec command.

Ctrl+0 Starts the currently selected file.

If current selection is an executable, Filefind concatenates the file's drive and 
path to the file name and starts the file.    FileFind looks in the WIN.INI to 
determine what file extensions to consider programs.    FileFind will try to start 
the file if its extension is listed in the Programs item in the [windows] section 
of the WIN.INI file.    Typically, this line will look something like Programs=com 
exe bat pif.    In this example, FileFind will try to start a selection if its extension
is .COM, .EXE.,BAT., or PIF.

If the selected file cannot be started, FileFind will attempt to start a program 
associated with the extension and pass the drive, path, file string as a 
parameter.    FileFind looks in the [Extensions] section of the WIN.INI for an item 
corresponding to the extension.    If one is found, FileFind starts the program 
associated with that item with the selected file as a parameter.

Ctrl+1 Starts another instance of FileFind.

Ctrl+2-9 Executes a user defined menu command.

You can define up to 8 of your own commands to be executed.    Accelerator 
Ctrl+2 is associated with the RUN2 menu item, Ctrl+3 is associated with the 
RUN3 menu item, etc.    See configuring Filefind for more information.    If you 



choose one of these menu items, Filefind starts the defined program and 
passes a string containing the drive, path, and filename as a parameter to the 
program.
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Select Menu Commands

List Dir(s) Creates a file list of the files in the selected directory(s).    This 
command ignores the file specification but respects the attribute 
selections and since option.

List Dir(s) w/Spec Creates a file list    of the files in the selected directory(s) based on the 
search specification.    This command respects the attribute selections 
and since option.

Printer allows you to choose and/or configure a printer.    Additionally, 
allows you pop up the windows Control Panel program.

Exit Exits FileFind.



Edit Menu Commands

Copy creates a copy the current selections and places it in the clipboard.    
Whatever is being shown on the display is copied to the clipboard.    For
example, if you include file sizes in your view, they will be copied to the
clipboard.    The filename is always copied.

Cut removes the current selections and places them in the clipboard.    
Whatever is being shown on the display is copied to the clipboard.    For
example, if you include file sizes in your view, they will be copied to the
clipboard.    The filename is always copied.

Copy List creates a copy the entire file list and places it in the clipboard.    The list
is copied as shown.    File attributes such as date and size are written to
the clipboard if they are currently being shown.

Cut List removes the entire list and places it in the clipboard.    The list is copied
as shown.    File attributes such as date and size are written to the 
clipboard if they are currently being shown.



View Menu Commands

Date Toggles whether the file date is displayed in file list windows.    The 
format is mm-dd-yy (ex. 3-03-91).    A check mark by the menu item 
indicates that dates are displayed.    If a check mark is not by the menu
item, it will not be displayed.

Time Toggles whether the file time is displayed in file list windows.    The 
format is hh:mm:ssm (ex.7:40:00p).    A check mark by the menu item 
indicates that time is displayed.    If a check mark is not by the menu 
item, it will not be displayed.

Size Toggles whether the file size is displayed in file list windows.    A check 
mark by the menu item indicates that time is displayed.    If a check 
mark is not by the menu item, it will not be displayed.

Attribute Toggles whether the file attribute is displayed in file list windows.    The 
format is rmdahsv(read write/read only, directory, archive, hidden, 
system, volume label.    A check mark by the menu item indicates that 
time is displayed.    If a check mark is not by the menu item, it will not 
be displayed.

Drive Toggles whether the file's disk drive is displayed in file list windows.      
A check mark by the menu item indicates that the drive is displayed.    
If a check mark is not by the menu item, it will not be displayed.

Path Toggles whether the file's path is displayed in file list windows.    A 
check mark by the menu item indicates that the path is displayed.    If a
check mark is not by the menu item, it will not be displayed.

Concatenate Path Displays the path and file as one string.    This item alternates with the 
Separate Path item.

Separate Path Displays the path and file as two separate columns.    This item 
alternates with the Concatenate Path item.

Unsorted Displays the file or directory list in the order it was found.    This is the 
default when a file list is brought up.

by Name Displays the file or directory list in order by name then extension.    This
is the default for the directory list.

by Kind Displays the file list in order by extension then name.    This option is 
only available for file lists.

by Date/Time Displays the file list in order by the file date then the file time.    
This option is only available for file lists.

by Size Displays the file list in order by file size.    This option is only 
available for file lists.



List Menu Command

Switches the display to the file list.    This command is only available when a file list is 
present.



Tree Menu Command

Switches the display to the directory tree.    This command is only available when a 
directory tree is present.



Search Menu Command

Invokes the Search dialog.    The Search dialog is the central point for selecting drives,
choosing attributes, entering file specifications, etc.



Action Menu Commands

Delete Selections Deletes some or all the entries in the selection list.

Print Selections Prints some or all the entries in the selection list.

Copy Selections Copies some or all the entries in the selection list to another 
directory or disk drive.

Move Selections Moves some or all the entries in the selection list to another directory 
or disk drive.

Rename Selections Renames some or all the entries in the selection list to another set of 
names.

Change Selection &Atts Changes file attributes for some or all the entries in the 
selection list.

Add Directory Changes file attributes for some or all the entries in the selection list.

Selection Starts the current selection.

If current selection is an executable, Filefind concatenates the file's 
drive and path to the file name and starts the file.    FileFind looks in the
WIN.INI to determine what file extensions to consider programs.    
FileFind will try to start the file if its extension is listed in the Programs 
item in the [windows] section of the WIN.INI file.    Typically, this line will 
look something like Programs=com exe bat pif.    In this example, 
FileFind will try to start a selection if its extension is .COM, .EXE.,BAT., or 
PIF.

If the selected file cannot be started, FileFind will attempt to start a 
program associated with the extension and pass the drive, path, file 
string as a parameter.    FileFind looks in the [Extensions] section of the 
WIN.INI for an item corresponding to the extension.    If one is found, 
FileFind starts the program associated with that item with the selected 
file as a parameter.

Filefind Start another FileFind.    This is simply a simple way to start 
multiple copies of FileFind.

User items Starts the specified program and passes the current selection as a 
parameter to the program.    The drive and path are concatenated to 
the filename.    See Configuring FineFind for instructions on setting up 
user menu items.



Options Menu Commands

Set Defaults Invokes the dialog that sets FileFind defaults

Set Options to Defaults Sets the display options back to the current default settings.

Register License Invokes the Registration procedure.



Procedures

Configuring Filefind
Configuring a Printer
Invoking Control Panel
Launching Programs
Setting Search Parameters
FIle List Selections
Other Procedures



Other Procedures

The following menu contains a list of the less frequently used procedures.    Common 
procedures are listed in the Index.

to be issued



Configuring Filefind

Filefind can be configured in several ways.    Some of these are configurable within FileFind 
while others require editing the WIN.INI file.

To set configuration options within FileFind, Choose the Options menu and the Set 
Defaults menu item.    Except where noted, any changes made in this dialog will be saved in
the INI file if the OK button is pressed.    If the Cancel button is pressed, no changes are 
saved in the INI file.

Initial Display The Display group box contains a check box for each of 
the display options that control what the file list display 
looks like.    A display option that is checked will cause 
that option to be displayed in file list windows.    
Unchecked display options will be suppressed.

Initial File Attribute Filters The Attributes group box contains a check box for each
of the possible file attributes.    If an attribute is 
checked, FileFind will initially include that attribute in its
search and match processing.    If an attribute is 
unchecked, FileFind will not include that attribute in its 
search and match processing.    In order for a file to be 
found, at least one attribute that is included in search 
and match processing must be set.    

Save Window Size This check box allows you to save the current size of the 
FileFind window as the initial size to use when FileFind is 
started.    Simply size FileFind as you want it to appear 
initially, check this button and press OK.

File Search at Start If checked, this automatically invokes the Search dialog 
when FileFind is started.    If it is unchecked, you must 
invoke Search yourself.

Initial Drive FileFind can start at any drive you wish be scrolling the 
initial drive scroll bar.    As you scroll, you will see each of
the drives in your system displayed.    Leave the scroll 
bar at the desired drive.    If you wish to have FileFind 
default to the 'current' drive, scroll completely to the left 
until you see default drive appear as the drive.    FileFind 
will now default to whatever is the current drive when it 
starts up.

User Defined Menu Items
The one configuration item that you can not set within FileFind is the user defined 
menu item.    User defined menu items are saved in the WIN.INI file in the same 
section as the above options.    You should set one or more options as above to let 
FileFind setup the section name that is required before adding user defined menu 
items.    User defined menu items may be added to the INI file with any editor you 
wish.    The user defined menu items are all placed in the [SRS File Finder] section 
of the INI file.    The order is not important so long as you place these lines after [SRS 
File Finder] and before the next [section].



You may define up to eight of your own menu items in the Action menu.    Entries 
take the form listed below.    White space is indicated by <space> and may contain 
one or more space characters.

Runx=menutext <space> [drive:][path]program_name
Where:

x is a single digit 2-9.
menutext is the text to be displayed on the menu.    If you precede a 

character with an ampersand (&), it will appear underlined and 
be the accelerator for that menu item.

[drive] is an optional disk drive specification to the program to be 
started.    Use A:, B:, etc.

[path] is an optional path to the program to be started.
program_name is the program to be started.



Configuring a Printer

The currently selected printer or any printer in the listbox may be configured within Filefind.

To configure a printer Invoke the Select menu and the Printer menu item.    In the Printers 
dialog, make sure that the printer you wish to configure is selected.    Press Setup to invoke 
the printer's configuration dialog.    The details of printer configuration vary from printer to 
printer.



Invoking Control Panel

Filefind can launch Control Panel or bring it to the top if it is already running.    Invoke the 
Printer dialog.    In the Printer dialog, press the Control Panel button.



Launching Programs

Filefind can launch additional instances of Filefind and user defined programs.

Launching another FileFind
Select the Action menu and the FileFind menu item to launch another instance of 
FileFind.    You many also use Ctrl+2.

Launching programs from the file list
If the file list contains a windows program (e.g. *.EXE, *.PIF), you may launch the file 
as a program in three ways.    The easiest way is to double click on the file list item.    
You may also select the file list item by clicking on it and then selecting the Action 
menu and Selection menu item.    Finally the Ctrl+0 accelerator will invoke the 
selected file list item as a program.

Launching associated programs from the file list
If the file list contains a file whose extension is associated with another program (e.g. 
*.TXT brings up NOTEPAD.EXE), you may launch the associated program with the 
selected file as a parameter.    The easiest way is to double click on the file list item.    
You may also select the file list item by clicking on it and then selecting the Action 
menu and Selection menu item.    Finally the Ctrl+0 accelerator will invoke the 
selected file list item as a program.

Launching programs for user defined menu items.
In the above example, *.TXT files were associated with NOTEPAD.EXE.    If you wish for
this default association to continue, but need to occasionally launch a different 
program for any given file, you must configure FileFind for a user defined menu item 
for each program.    To launch one your programs, select the file from the file list by 
clicking on it.    Then select the Action menu and the menu item that will invoke the 
desired program.    Each of these menu items as an accelerator defined for it.    To use 
the accelerator, press Ctrl+x where x is the number used in the Runx configuration 
of the user defined menu item.



Setting Search Parameters

The search parameters are set in the Search dialog.    You can tailor your search by 
specifying what disk drive(s) to search, wild card file specifications, file attributes to match, 
file age, and whether directories with extensions will be searched.    Less frequently used 
search parameters are accessed by pressing More>> to expand the dialog.    The dialog may
be shrunk again by pressing <<Less while it is expanded.

Disk Drives
The search dialog present a set of check boxes that correspond to the drives 
accessed by your computer.    By checking or unchecking these boxes, you can tailor 
which drive will be searched.    Each time you come in to the search dialog, the 
previous (or default) selections are pre-checked.    You must uncheck any that you no 
longer wish to use and check any new ones.

File Specifications
File specifications are the same as you would use for the DOS DIR command.    The ? 
indicates that any character will match in that one position.    The * indicates that any
file matches up to the position containing the * is a match.    Current versions of DOS 
allow you to specify ABC*D.*.    However, this specification is no different than ABC*.*.

File Attribute Filtering
A series of check boxes allow you to include files that have a particular attribute set.   
For example, if you only want to see read-only files, check the read-only check box 
and leave all the other attributes unchecked.    If you want to see all files that are 
either read-only or have their archive attribute set, check the read-only and archive 
boxes while leaving the others unchecked.    The volume label and directory check 
boxes work a little differently.    When these are checked, the files are included.    
When they are unchecked the volume or subdirectory files will not be displayed 
regardless of their other attribute settings.

File Age Filtering
To select only files that are new or have been modified within a certain number of 
days, use the within option.    To use this, check the Within check box and enter a 
positive number of days.    FileFind will ignore any files that are older than the number
of days entered.

Ignoring Directories with Extensions
If the .EXT Directories check box is checked, all directories are searched.    If it is left
unchecked, any directories with an extension are bypassed.    The main reason for 
including this option is to speed your searches.    Ignoring directories with extensions 
can cut your search time by as much as 50% even if you don't have any directories 
with extensions.    While this may change in future versions of DOS, it also allows you 
to configure your disk to ignore certain directories.    For    example, if you move files 
to an archive directory before deleting the files and never want to search the archive 
directory, simple name it something like DELETE.ARC and leave the .EXT 
Directories check box unchecked.



File List Selections

Filefind allows you to select any combination of files in the file list for further action such as 
moving, deleting, etc.

You can select any combination of files by clicking the mouse by itself, while pressing the 
Shift key, while pressing the Ctrl key, or while pressing both the Shift and Ctrl key.



Error Messages
Can not copy a Subdirectory

A subdirectory is in the selection list and you have invoked the copy 
command.    Filefind can not copy subdirectories.

Can not copy a Volume Id
A volume label is in the selection list and you have invoked the copy 
command.    Filefind can not copy volume labels.

Can not delete Volume Id
A volume label is in the selection list and you have invoked the delete 
command.    Filefind can not delete volume labels.

Can not make directory Path.Name
You have attempted to add a directory and FileFind was unable to add the 
name.    Path specifies the drive and directory up to the directory that you are 
try to add a new directory under.    Name is the name you typed in.    The most 
probable cause is that you have entered illegal characters in the name such 
as *.    The other most probable cause is that you have exceed the path limilts 
for DOS.    This is currently about 63 characters and includes slashes.

Can not move a Subdirectory
A subdirectory is in the selection list and you have invoked the move 
command.    Filefind can not move subdirectories.

Can not move a Volume Id
A volume label is in the selection list and you have invoked the move 
command.    Filefind can not move volume labels.

Can not move to the same directory
An attempt to copy or move a file to the same directory has been made.

Can not run menu item xxxx
You have attempted to invoke a user defined menu item.    xxxx is the 
associated program id.    Filefind does not consider the associated program id 
to be an executable file.    If the associated program id is an executable file, 
your win.ini file may be in error.    See the section on installing Filefind for 
further information.

Can not run selection xxxx
You have attempted to invoke a selection that Filefind does not consider an 
executable file.    xxxx is the associated program id.    If you have selected 
what you think is an executable file, your win.ini file may be in error.    See the 
section on installing Filefind for further information.

A Directory is not Currently Selected.
The list directory or list directory w/spec menu item has been invoked.    
However, you have not yet selected a directory tree item.

Do not ignore these messages.
You are running an unlicensed copy of Filefind and clicked on the Ignore 
button.    You can not ignore these messages.    You should also license you 
copy of Filefind.

- Error S1002 - File Limit Exceeded
Some versions of Filefind have a built-in limit to the number of files that may 
be found.    

File not found
No files matching the entered file specification were found.    Check the 
specification.    Also make sure that you specified the correct disk drive.

No files selected
A delete, move, print, or one of the user defined menu items has been 
requested, but no file has been selected.

No files to show
Filefind could not find any files to show.    This may come from a file search, 
trying to list files in an empty directory, etc.



Not a valid license Id
You have entered the license registration id and clicked the OK but the id is 
invalid.    Correct and re-try.

Not enough memory to construct selection string
Not enough memory exists construct a string of the selections.    Free some 
memory by closing existing applications.

Not enough memory to continue
Filefind needs to allocate memory and there isn't enough available.    This can 
occur while Filefind is searching the disk and building lists of directories and 
matching files, when copying a file, or moving a file.    If you are running in 
Real Mode, freeing up memory from other windows applications may help.    If 
you are operating in Standard or 386 Enhanced mode, this should only occur 
while Filefind is building the file list based on a search specification that is 
finding hundreds of files that match the search specification.    Try narrowing 
the search specification.

Not enough memory to create destination path
An attempt to copy or move a file is being made.    Not enough memory exists 
to create destination directory information.    

Rename Failed with DOS Error xxxx
You attempting to rename a file and a DOS error has occurred.    xxxx is the 
DOS error number.

Overwrite xxxx 
A copy operation has been specified and the file already exists in the 
destination directory.    If you want to write over the existing file, click on OK.    
Click on Cancel to leave the existing file in the destination directory intact.

Unable to delete Directory filename.ext
Filefind is unable to delete the directory filename.ext.    The most likely cause 
is that the subdirectory contains other subdirectories or files.    Filefind can 
only delete empty subdirectories.    Other reasons are that it is a read-only file 
or that it is one of your current directories (i.e. some windows or DOS program
is using the directory).

Unable to delete File filename.ext
Filefind is unable to delete the file filename.ext.    The most likely cause is that 
the file is a read-only file.

Within days are invalid
The days to use for the Within filter is invalid.    This value must be a positive 
number.

xxxx opening destination file
A DOS error has occurred trying to open the destination file for a copy or 
move.    xxxx is the DOS error code.

xxxx opening source file
A DOS error has occurred trying to open the source file for a copy, move, or 
print. xxxx is the DOS error code. 

xxxx reading source file
A DOS error has occurred trying to read the source file for a copy or move.    
xxxx is the DOS error code.

xxxx writing destination file
A DOS error has occurred trying to write the destination file for a copy or 
move.    xxxx is the DOS error code.



Versions

Current Version
Previous Version
Other Versions



Current Version 3.4

* Added multiple drive support.    Changed the drive select to check boxes that 
automatically configure to the current drive set.    Added drive and path 
display toggles.

* Added total and free bytes on selected drive.    If multiple drives have been 
selected, the first drive is shown.

* Improved attribute filtering.

* Fixed keyboard scrolling problem for win 3.1

* added file rename, change attributes and directory adding.

* added printer change dialog.



Previous Version 3.3

* Added on-line help facility, revised Edit menu to be more standard, added 
several accelerators (3.35).

* Added delete capability for Read-Only files (3.31).

* Added a Within option that allows selecting files that match the file spec and 
that have been created or altered within the last 'n' days (3.30).

* Fixed bugs in Read Only and Archive attribute filtering (3.30).



Other Versions

Version 3.20 December 11, 1990
* File Attribute Filtering is available.    Desired attribute matching patterns may 

be saved to the win.ini file.
* The time required to build the directory tree can be shortened by as much as 

50% by using a new option in the search dialog.
* The search dialog has been enhanced to include tree building from this dialog. 

Attribute selection is included in this dialog as well as the default dialog.    The 
Build Tree Item in the File command is currently retained for compatibility, but 
will be removed in future versions.

Version 3.00
* Version 3.00    is essentially a essentially a 1.7 version upgraded to true 

Windows 3.0 rather than compatible to 3.0.    It is no longer 2.x compatible.

Version 1.70 October 1, 1990
* Version 1.7 introduced a Windows 3.0 compatible version as well as several 

enhancements.
* The tree display allows the same multiple selections as the file list.    The 

directory searches are performed on all selected directories.
* The FileSpec dialog has been changed to allow setting the search specification

without actually invoking the search.    This is useful for when the initial search
is for a filespec in selected directories.    The OK button has been renamed 
Search and the new button is named Set.

* Copying the selection list or the entire file list to the clipboard has been 
added.    File times, dates, etc. may also be optionally copied to the clipboard.

* Running Selections has been enhanced.    Filefind now checks the programs as 
it always did, and if it can not run the file as a program, looks for an 
associated program in the [Extensions] section of the WIN.INI file.    If one is 
found, the associated program is started and the selected file is passed to it 
as a runtime parameter.

* The Run and Action menus have been combined into one Action menu.    This 
was done mostly because I dislike two line menus, was adding the Edit menu 
and wanted to keep the menu on a single line without forcing the horizontal 
size to cover the whole screen.

* An Edit menu has been added to support the Copy List and Copy Selections 
clipboard functions.

* View and Action menu items are grayed when they can not be used rather 
than giving an error message.

* Previously, the files listed by the first search done would be in DOS order.    
The same search performed a second time would match the tree order.    Now 
the first search also matches the tree order.

* The <End> key in scrolling has been fixed to always show the last line in the 
scrolled list.    Left and right cursor keys have been changed to scroll one 
character rather than a full screen.

* The print function occasionally printed blank pages instead of the file.

Version 1.5 December, 1989
* Filefind allows directories to be listed by selecting the desired directory 

from the tree display.    All files or all files meeting the current search 
specification may be listed.

* Deselecting the file list by clicking in the non-client area is no longer 
supported.    Files are now deselected by clicking on a selected file.    Selecting 
below the last file in a list caused intermittent failures.



* Filefind may now be started by initiating a file search, a tree listing, or 
neither.

* Tree displays may now be invoked without going through a full file search.
* Empty directories may be deleted.
* The main menu contains a toggle to switch between the directory tree display 

and the file list display.
* The file path separation / concatenation is now a toggle rather than two menu 

items.

Version 1.2 July, 1989
* Original shareware release



Help Conventions

Note the following conventions.    

References to dialogs are listed in BLUE.    The reference may be the title of the dialog
when it is active or the menu item text that invokes the dialog.

References to user actions such as using accelerator keys and pressing certain push 
buttons are listed in MAGENTA.    


